Control(4

Better. Together.

Composer HE Getting Started




Composer HE Getting Started

Control4 Disclaimer

Control4® makes no representations or warranties with respect to this publication, and specifically disclaims any express or
implied warranties of merchantability or fitness for any particular purpose. Control4 reserves the right to make changes to any
and all parts of this publication at any time, without any obligation to notify any person or entity of such changes.

Trademarks

Control4 and the Control4 logo are registered trademarks of Control4 Corporation. Other product and company names
mentioned in this document may be the trademarks or registered trademarks of their respective owners.

Legal Notice
GNU

GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
(Section 3.b.)

You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the
terms of Sections 1 and 2 above provided that you also do one of the following:

Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of
physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 on a medium customarily used for software interchange.

The complete text for this license is available on the Control4 web site at: http://www.control4.com.
Gracenote

Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either a registered trademark or a
trademark of Gracenote, Inc. in the United States and/or other countries.

Music and DVD recognition technology and related data are provided by Gracenote®.

Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. For more information
visit www.gracenote.com.

MPEG

Fraunhofer IIS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. Supply of
this product does not convey a license nor imply any right to distribute content created with this product in revenue-generating
broadcast systems (terrestrial, satellite, cable, and /or other distribution channels), streaming applications (via Internet,
intranets, and/or other networks), other content distribution systems (pay-audio or audio-on-demand applications, and the like)
or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards, and the like). An
independent license for such use is required. For details, visit http://mp3licensing.com. Radio Locator is the service provider of
AM/FM channel list.

© 2005-2008 All Media Guide, LLC provides music and video recognition technology that provides cover art and related text
that enriches the Control4 user Navigators.

Copyright

© 2013 Control4. All rights reserved. Control4, the Control4 logo, the Control4 iQ logo and the Control4 certified logo are
registered trademarks or trademarks of Control4 Corporation in the United States and/or other countries. All other brands or
names may be claimed as property by their respective owners. Pricing and specifications subject to change without notice.

No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express
written consent of the publisher.

Contact Information

Control4 Corporation

11734 S. Election Road

Salt Lake City, UT 84020 USA
http://www.control4.com

Part number: 200-00169
Composer Home Edition Getting Started (OS 2.5.0)

Copyright © 2013 Control4. All Rights Reserved.

Saved: 6/4/2013 9:59:00 AM 200-00169 Composer HE Page 2 of 48
Getting Started_2.5.0.docx


http://www.control4.com/

Composer HE Getting Started

Contents

I 11 0T [T 1 ISR 5
1.1 U1 o101 < TP 5
1.2 Related DOCUMENES @Nd RESOUICES .....cooeeiiiiiii e eee ettt e e e e e e e e e e e e e eeeeennnns 5
1.3 What's NeW iN ThiS REIEASE?.......uuoiii e e e e s 5
R 20 R © 2 T B O PP PP PPTPPPPPPPRPRRN 5
1.4 Introducing Composer Home Edition (HE) ..........vuiiiiiiiiiiiiiiiiiiiiieiiiiieieeeeeeenneeee 6
1.4.1 What You Can Do in ComMPOSEr HE.........ouuiiiiiiiceice e 6
O o 1] ([ {0 1 1S 8
1.4.3 Important BasiC PrNCIPIES ...couuuuiiii e e e e e e e e ra s 8
N € 1= i 1] oo TR €= U (=T PSSP 9
2.1 INStalling ComMPOSEr HE.........oooiiiiii e e e e 11
2.1.1 Composer HE Software and Hardware Requirements...........ccceovveeviiieiiiiiieieeeee e, 11
2.1.2 INStall the SOWAIE ......cooeiiiii e e e e e e e 12
2.2 Before YOu Use COMPOSEr HE ........ooiiiiiiiiiiiiieeiee et 13
2.2.1 Create Your my.control4.CoOm ACCOUNL ..........coeuuiiuiiieeeeeieiiiies e e e e e et e e e e e e 14
2.2.2 Register the System on my.CONtrol4.COML..........ooouiiiiiiiie e 15
2.2.3  SeLUP REMOIE ACCESS. ..t ittt ittt e e e e e e e e e e e e et e eean s 15
2.2.4 Set Up a 4Sight SUDSCHPLION .......coiiiiii i 16
2.2.5 Activate CompPoSer HE .......ouuiiiii i 17
2.3 Starting ComMPOSEr HE.........uuiii e e e 18
R T S v 1 (1 o IO o] 1 o] 1= RSP 19
ARG I A OFo 4 g [=Toi (o T D1 (=T ex (o] gru 19
2.4 EXItING COMPOSEE HE .....ouiiiiiiiiiiiiiii e 23
3. EXPIOring the INLEITACE ......ooeiiiii e e e e e e e e et eeeeeeeeanes 23
3.1 VBV ittt et e e e e e e et e e et e ee et e e et et e eeata e eeeta e aeat e aeatt e aeartas 24
3.1.1 Monitor and Control Lights, Thermostat, etc. (MONItoring VIEW) ...............euvvvvvevvvvernnennnns 25
3.1.2 Manage Digital Music and DVD Collections (Media VIEW) ..............cuuuurrerremmimiiiiiiiiiiiinnnns 28
3.1.3 Use Intelligent AgeNnts (AQENLS VIEW) ....iiiiiiiiiiiiie et e et e e e e e e e e 30
3.1.4 Program the Control4 System (Programming VIEW) .........ccuuuuuiiiieerrieeiiiiiiiieeeeeeeniiiieeeens 32
TNt T Y/ 1= o T I @ o) 1o o 1S 36

I I G | PRSP PP PP PRSPPI 36

I I A Y/ 1= T [ - RS RRRPRRRN 37

G 700 08 S T I o To 38
0 T o = o 42

Copyright © 2013 Control4. All Rights Reserved.

Saved: 6/4/2013 9:59:00 AM 200-00169 Composer HE Page 3 of 48
Getting Started_2.5.0.docx



Composer HE Getting Started

4. WHEre t0 GO fTOM HEIE ...coiiiiiiiiiiiiieiieeee et 42
B BIOSSANY ...ttt — 43
LG T [ o [ GO SEPPPRR 47
Copyright © 2013 Control4. All Rights Reserved.
Saved: 6/4/2013 9:59:00 AM 200-00169 Composer HE Page 4 of 48

Getting Started_2.5.0.docx



1.1

1.2

1.3

Composer HE Getting Started

Introduction

Control4® Composer Home Edition (HE) is a powerful software application that lets you, the home or
business owner, customize your own Control4 system. Your Control4 dealer has installed and
configured your Control4 system using the professional version of Composer. The Composer HE
application was created just for you.

This document applies to Control4 Operating System (OS) Release 2.5.0 (OS 2.5.0). Check with your
dealer to make sure you have Composer HE for OS 2.5.0.

Purpose

The purpose of this document is to give the reader an introduction to the Composer HE application
and what you can do with it. For more detailed information, see the Composer HE User Guide.

Note: Words that appear in red are either in the Glossary or provide examples, tips, and important
information.

Related Documents and Resources

You can find the following related documents in PDF or web help format in the Residential
Documentation page at: http://www.control4.com/residential/products/resources/.

e Composer Home Edition User Guide (200-00170)

e Control4 System Quick Start Guide (200-00153)

e Control4 System User Guide (200-00001)

e Control4 System Remote Control SR-250 User Guide (200-00152)
e Composer Media Edition User Guide (200-00171)

e Control4 MyHome Setup Guide for Homeowners (DOC-00004)

What's New in This Release?

The Control4® Composer HE software and hardware updates are detailed below. This version
includes changes for OS 2.5.0 and later (see the latest version first).

131 0S 250

1.3.1.1 Hardware and Software Support

e Added support for the Wireless Music Bridge, a device that lets you play music stored on or
accessed via your smartphone, computer, or tablet. Enjoy streaming music and cover art from
your Internet sources throughout the home. See the Wireless Music Bridge documentation on the
dealer and Residential Documentation pages and the Composer Pro User Guide for details.

e Removed support for Microsoft Windows XP.

e Added support for the new ZigBee lighting devices for U.S. and international markets:
= Forward Phase Dimmer, 120V
= Adaptive Phase Dimmer, 120V
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e New advanced lighting devices that work with panelized lighting:

Composer HE Getting Started

Adaptive Phase Dimmer, 277V
Adaptive Phase Dimmer, 240V
Keypad Dimmer, 120V
Keypad Dimmer, 277V
Keypad Dimmer, 240V
Configurable Keypad, 120/277V
Configurable Keypad, 240V
Switch, 120/277V

Switch, 240V

Aucxiliary Keypad

0-10V Dimmer, 120/277V
0-10V Dimmer, 240V

Fan Speed Control

Bus Power Supply
Bus Ethernet Gateway, DIN Rail
4-Channel Bus Dry Contact Input

1.3.1.2 New or Updated Sections
e Glossary updates.
e General edits.

1.4 Introducing Composer Home Edition (HE)

1.4.1 What You Can Do in Composer HE

You can:

e Customize your Control4 system

from a Windows PC on your home's local network.

from any Internet-connected Windows PC (this capability requires a Control4 4Sight

subscription).

e Monitor and control

Dimmers, switches, and keypads,
Wireless Thermostat,

Security system, or

other devices from your Windows PC.

e Configure the Control4 devices on your system to

set LED colors on lights and keypads,

set the ramp rates and the default levels of your Control4 wireless dimmers,
set your Control4 Wireless Thermostat schedule, and

program the device-specific buttons on your Control4 System Remote Control.
e Manage your digital music and DVD collections.

Copyright © 2013 Control4. All Rights Reserved.
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e Configure your system using a variety of intelligent agents (your dealer must add the agent to
your Composer project first):

e Use Media Scenes to tie together the audio source selection, volume control, and on/off
state of multiple rooms so that they work as one.

e Use the E-mail Notification agent in programming to notify you when events occur on your
system.

e Create an Announcement agent to make announcements that display on touch screens
and on-screen Navigators.

e Create and modify custom lighting scenes.

e Use the Scheduler agent to program events based on date, time of day, and
sunrise/sunset.

e Create your own Wakeup scenes.
e Use the Macros agent to create a common programming script.
¢ Do much more with other agents. See “Agents” later in this guide.

e Program your system to behave as you want it to. Tie together all the capabilities of the Control4
environment into a single, controllable, and programmable system.
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Restrictions

While Composer HE is a fully functional application that lets you customize your Control4® system, it
does not provide all the functionality of the Composer Professional (Composer Pro) version that your
Control4 dealer uses. Should you ever get stuck, your dealer can help.

Contact your Control4 dealer if you ever need to

e create a new Control4 system,

e add devices to your system (or remove devices),

e create or edit drivers for third-party products,

¢ install updates to system software,

e perform complex programming, or

o perform other tasks that are beyond the capabilities of you or the software.

If your system has been configured to connect to Control4's 4Sight service, your dealer can perform
many of these services over the phone and on the web without having to schedule a service call at
your home.

Important Basic Principles

Your Control4® dealer or Installer has installed and configured your Control4 system to your
specifications based on your purchase agreement. While individual Control4 dealer policies may vary,
most dealers will charge you for additional service calls unless you have a service contract.

One of the benefits of using Composer HE is that you can customize parts of the Control4 system
yourself which can save you some money. Should you require your dealer's assistance, however, you
must be prepared to pay for that assistance. Check with your dealer for details.

CAUTION! When using Composer HE, you are configuring your own Control4 system. While this
gives you a great deal of capability, it also carries some risk for which you must be prepared to take
responsibility. If you disable your system, your dealer may need to fix it for you, and this could cost
you extra.

This section describes some of the basic principles when using Composer HE on your Control4
system. It is important to understand these principles and accept the risk and responsibilities that
come with customizing your system yourself.

1. Changes you make in Composer HE. When you connect to Director and customize your
system, the changes are effective immediately. Whether you're changing LED colors or dimmer
ramp rates, performing complex programming, or creating agents, Director immediately modifies
your system configuration.

2. Thereis no ‘Undo’ capability. If you make a change you don't like, there is no way to "undo”
that change. You have to configure or program the project back to the way it was, or load a
backup copy of the project you've previously saved. Therefore, Control4 recommends that you
always make a backup copy when you save or change your project.
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You can save and restore your Control4 system. An important capability provided in
Composer HE is the Backup or Backup As option; these options save your system configurations
to a project file on your PC's local drive. If you ever need to restore the system to the state you
saved, you simply load the saved project file.

When you load a project file, you reset your current system configuration. Loading a project
file on your system clears and resets any current system configurations you've made in an
existing project. You will lose any customization you've done; the changes are not in the project
file you load.

Project files can be backed up with and without media. When you back up your project file,
you can create the backup with or without media. If you load a project file that doesn't have any
media associated with it, you will lose the media that was associated with your current system. It's
always a good practice to back up your project with your media when you exit Composer. If you
ever need to restore your system, your media database is still intact. Tip: If you forget to back up
your media, you can always go back to a previous backup with the media loaded. This may
change your system configuration, however, to the old configuration in that backed up project.

You can separately export media and playlists. You can export the media database
information for each media source on your Control4 system. You can also export playlists. If you
import media and playlists, the current media list for that media source and the current playlists
will be cleared and replaced with the media in the file you are importing.

Backups with media and exported media lists only include the media database information.
Backups and exported media lists contain the media database information used by the Control4
system. These lists do not contain the actual media (MP3) files. To back up the media files, you
should separately back up the media source (to a controller with disk space, USB storage, or a
network file storage device) when you exit Composer HE.

Programming can be associated with multiple events. Control4 system programming lets you
program your system to perform similar tasks in a variety of ways. For example, you can set the
LED color as a device property, and you can change that property in programming too.

Note: Pay close attention to your programming changes so that you don't inadvertently change
the behavior of your system in an undesirable way.

Your system may become inoperable due to certain types of changes you can make using
Composer HE. It is possible that you could make your system inoperable using Composer HE. In
most cases, you can recover your system using a backup project file. However, if you can't
recover your system using a backup project file, contact your dealer for assistance. Your dealer
can restore your system back to an operational condition.

Getting Started

Composer HE is a Windows-based PC program that has an intuitive drag-and-drop interface which
gives you the opportunity to view and configure your devices, manage your media, and create simple
programs, for example, changing lighting scenes, modifying custom buttons, and controlling behaviors
among devices. The following screen displays when you first start Composer HE.
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Composer HE main screen:
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The brains and heart of the system is the Control4 controller, for example, the HC-800 Controller. The
controller communicates with Control4 and third-party products compatible with Control4 to enable
home automation and interaction of individual devices. Whenever the term “controller” is referenced in
this document, it refers to any Control4 product that contains the Director software, for example, HC-
250 Controller, HC-800 Controller, HC-1000 Controller, the new Sony STR-DA2800ES with full
Control4 Automation, the Sony STR-DA5800ES with full Control4 Automation, and so on.

The sections in this guide will give you startup information so you can begin to use Composer HE.
When you're ready to start using Composer HE, refer to the Composer HE User Guide.

In this document, you'll learn how to

e install Composer HE

e activate an account for Internet access
e start and close Composer HE

e connect to a Director

e begin to use the Composer HE interface
e review the views and menu options

Copyright © 2013 Control4. All Rights Reserved.
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2.1 Installing Composer HE

The following illustration shows how a small home network might be set up. The laptop shows the
Control4® Composer software installed on it. Your installer may have set up a network similar to this
one.

//

Internet

Cable/DSL
Modem

Router
(with Wireless
Access Point)

Control4 Controller

e
N _

2.1.1 Composer HE Software and Hardware Requirements

e Control4 primary controller (for example, HC-800 Controller) added and configured to the
Composer project

e PC software and hardware:
e Composer HE software

e Microsoft. NET 1.1 and Support Pack 1 (installation automatically started from Composer
Install on the Control4 website)

e Microsoft operating systems supported
e Windows 7, 8
e Windows Vista
e 500 MHz processor or higher
¢ 256 MB RAM
e 90 MB hard disk space
e Video card and monitor supporting resolution of 1024 x 768 or higher
e Keyboard
e Mouse
e 1-2 Ethernet (CAT5 or CAT6) cables

e TCP/IP-based home network (DSL/Cable Modem, Control4 Secure Gateway, router, or switch) to
connect the PC to the controller

Copyright © 2013 Control4. All Rights Reserved.
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Internet connection (broadband required when using Remote Access, retrieving cover art, or
accessing many other services)

Windows Media Player 9

Wireless access point (WAP) that supports 802.11 b/g/n (optional)
Installation software

Controller registration

Install the Software

To use Composer HE with your Control4 system:

1.

Install the Composer HE software on the PC that you will be using to configure your Control4
system. Both your PC and your controller must be connected to your TCP/IP-based-home
network. Composer HE is provided to you by your Control4 dealer or installer via an Internet URL
path for download.

Tip: Control4 recommends that you install Composer HE on a PC laptop. Laptops are very handy
to move about the home or business as you set up your project and test your devices.

Register and create a user account on the Control4 my.control4.com Internet site to activate
Composer HE. Refer to the instructions in “Activating Composer HE.”

To Install Composer HE:

1.

w

Download and run the installation program from the URL provided to you by your Control4 dealer
or installer. The Installation link contains the Composer HE software and this Composer HE
Getting Started as online help (a PDF of this guide is available on the Control4 website). The
Composer HE User Guide (the companion to this document) is available on the Control4 website
in web help or PDF formats.

Select Install Composer.
Follow the instructions provided to install Composer HE on your PC.

When prompted by the Install program, select continue anyway to install the Remote Access
Network Tunnel Adapter on your PC.

When the installation completes, click Finish. A Composer HE icon displays on your PC desktop
if you selected to have it installed there.

Click the Composer HE icon to start Composer HE.

Tip: The Start menu (Programs > Control4 > Composer 2.5.0 > Composer Directories) has
folders for the Drivers, Logs, and Projects in your system. For quick reference, you may want to
refer to these folders from time to time.

Note: Before you can use Composer HE, you must create a my.control4.com account and
register your controller. Follow the instructions next.
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2.2 Before You Use Composer HE
Prerequisites
Before you use Control4® Composer HE, you and/or your installer need to
e create an account at my.control4.com,
e register your controller to your project so it works with the system,
e set up Remote Access so your dealer can fix any problems remotely,
e set up 4Sight for remote access to the system, and
e activate your Composer HE software.
The first time you start Composer HE, the system prompts you for your myControl4 4Sight account
information and a Composer HE subscription code. 4Sight is a Control4 subscription Internet service.
The 4Sight Internet connection works well when you're away from home and you want to receive
email notifications or configure a device remotely using Anywhere Access from your smartphone,
tablet, or PC.
To activate Composer HE, create a my.control4.com account at http://my.control4.com (see below).
There is no charge to create this account.
Note: This setup may have already been done for you by your dealer. If you don’t know whether this
is true, check with your dealer either to obtain your account information (account name, emalil
address, password, and registration code) or to verify whether this needs to be done.
To use a 4Sight Internet connection, email agent, and Anywhere Access services for one (1) year,
you may use the 1-year 4Sight subscription included with each copy of Composer HE. Thereafter, you
may want to purchase an annual 4Sight subscription from your Control4 dealer so you can continue to
enjoy its benefits. See “Set Up a 4Sight Subscription” below for details.
Copyright © 2013 Control4. All Rights Reserved.
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2.2.1 Create Your my.control4.com Account
Everyone who has a Control4 system needs an account on my.control4.com.

To set up your account:
1. Using your Internet browser, go to http://my.control4.com.

Control(&

l]’ll 1'

curet | AFTTHIES

e, at -m\,limn [

What is my.controld com? Registering Your Controller Account Login

What's New TR PR e p—— ]

@ Rhopsody

2. Click the link under Registering Your Controller, or click create account at the top of the page.

Control @&

Why Create an
Account?

Create Consumer Account

Step 1 - Tell Us Wha You Are:

Already Registers
@ Lagn to yoor pecow

3. Atthe Create Consumer Account page, fill out the account information (in three (3) major steps).
Make a note of your Account Name, E-mail Address, and Password for future reference. You
will need this information every time you log in to my.control4.com.

4. Read through and agree to the Terms of Use.

5. Click Create Account to create your account. The software asks you if you want to register your
controller. If you want to do this now, go to the next step.
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2.2.2 Register the System on my.control4.com

If you haven't already done so, go to http://www.my.control4.com to register your controller. Ensure

that your my.control4.com account has been created.

To register the controller:

1. Atthe account Home page, click Register Your Controller to set up remote access.

2. Onthe Complete Registration page, click Yes.

3. Onthe Controller Registration Confirmation page, make note of the 10-digit registration code
that displays. This code is time-sensitive and must be used within 10 minutes. It provides a
temporary code used to exchange security parameters and set up the ability to create a secure
connection between my.control4.com and the controller.

4. Go to a Navigator (for example, a touch screen or on-screen Navigator), and select More >
Settings > Remote Access.

5. On a Navigator (for example, a touch screen), select the text box in Enter code, and then enter or
paste the 10-digit registration code when the keyboard appears.

6. When you are finished, select Activate. When activation is completed, you can use all media
services.

7. (Optional) While you are on that page, you may want to enable Remote Access. Select Remote
Access > Enable. This allows Control4 access for system updates, and is a required step in
enabling Remote Access into your system by your dealer when needed ( 4Sight subscription
required).

2.2.3 Set Up Remote Access

When you set up remote access for a Control4® system, you can log in to 4Sight from anywhere in the

world and monitor or control settings in your home. You can use the 4Store website also.

Prerequisites

Use the Navigators or my.control4.com to set up remote access. If you've already done this in the

previous section, you can skip these steps.

To set up remote access from a Navigator:

1. From the Control4 Home page of a touch screen or on-screen Navigator, select More > Settings.

2. Select or press Remote Access.

3. Select or press Remote Access > Enable.

Notes:

1. When you enable remote access, if you have a 4Sight subscription for this system (see “Setting
Up a 4Sight Subscription”), you can enter your email address and password, and then securely
log in to the home network from any Internet connection in the world. When you are in 4Sight, you
can use the Anywhere Access to monitor and control the lights, change the temperature (warm or
cool the home remotely), or check whether any doors or windows were left open. Refer to “Using
Anywhere Access” in the Control4 System User Guide for more information.

2. If your system is registered on my.control4.com and the controller is registered, the system is
accessible over remote access (without a 4Sight subscription) after a request by the Control4
dealer or Control4 Technical Support has been made to access the system on my.control4.com,

Copyright © 2013 Control4. All Rights Reserved.
Saved: 6/4/2013 9:59:00 AM 200-00169 Composer HE Page 15 of 48

Getting Started_2.5.0.docx


http://www.my.control4.com/
http://www.control4.com/residential/products/resources/

Composer HE Getting Started

AND you instruct the controller to “check in” which you can do from the Navigator's Control4
Home page; select More > Settings > Remote Access.

2.2.4 Set Up a4Sight Subscription

If you haven't already done so, use the Control4® my.control4.com account to activate a subscription.
The 4Sight service

lets your Control4 dealer access your system remotely
lets you use the 4Store website to purchase applications

lets you use Anywhere Access to manage your system from your smartphone, PC, or tablet
worldwide

To set up a 4Sight subscription:

1. Getthe 4Sight Subscription code for your system from your dealer. (If you've set up the
subscription yourself, you have the code.)
2. Log in at http://www.my.control4.com under Account Login using your my.control4.com email
address and password, and click Submit.
4 o EEx >
: i = gal
Get Ready wlll l ! uq
for home control ’“"
from dn\,awherﬂ at dn;lime <
What is my.contreld.com? Registering Your Controller -.M:cnum Login
s = =
Anytime, Anywhere Home Contrel Through 4Sight S coing oramise
3. From Account Administration, select the subscriptions link.
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4. Enter the subscription code, and then click Activate.

scoount peotle my profls  users eganzan cwnicass

Subscriptions

.......................

2.2.5 Activate Composer HE

The first time you start Composer HE, the software asks you for a subscription code. Ensure that
you've registered your controller.

To activate your Composer HE software:
1. From your PC, double-click the Composer Home Edition icon to launch Composer HE.

2. Enter the subscription code provided with your Composer HE software.

G activathon Required

Activation Required

Activation it 1equaed to Bcende the ConbioM Composer software on the cunent mackne.  To activate pou must

* Hiron 8 45ight accound o i contiphl, com
* He conneched ba He Intemast

* Harve the Subscription Code provided i pour Composss packagrg
Subscripion Code:

' Control (®

Emad addrass: [assocaled with 45ight scoount]

Pagpeoed

[isscommen | S coomti]

3. Your Composer HE subscription code will be similar to this: DC89-D37F-D528-7A4A, four 4-
character sets separated by dashes. Enter the subscription code provided with your Composer
HE package.

4. Enter the email address and password associated with your 4Sight account.

5. The email address and password must be the credentials associated with your 4Sight account at
http://my.control4.com.

6. Click Activate.
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2.3 Starting Composer HE
The first time you start Control4® Composer HE, the system prompts you for your 4Sight account
information and a Composer HE subscription code. 4Sight is the Control4 subscription Internet
service. Be sure to register your account first so you can get this number, and then write the
subscription number down when you get it (this is not the same number as the controller registration
code).
To start Composer HE:
1. You can connect to your project system and project two (2) ways:
= Double-click the Composer HE 2.x.x icon on your PC'’s desktop.
=  From the Start menu, select All Programs > Control4 > ComposerHE 2.x.x (e.g., from
Windows XP)

The startup screen appears.

Each time you start Composer HE, you will connect to your Control4 system either locally (click

Director on Local Network) or remotely (click Remote Director). See “Startup Options” and

“Connect to a Director” for more details.

On the Control4 system, the primary controller is the controller and Director that you connect to

from your PC. Connect to Director via an IP address.

Note: To connect to a Remote Director, first you must set up remote access. See “Before You

Use Composer HE.”

Startup screen:

Composer
Connect to:
Director on Remote Director
Local Network
|Q Exit Composer C t | @
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2.3.1 Startup Options

Use the Control4® Composer HE software installed on your PC to start the Composer HE application.

Ensure that you've registered and activated your account before you start Composer HE for the first

time. See “Before You Use Composer HE” for details.

When starting Composer HE, you select the type of Composer connection you want (local or remote),

and your controller’s IP address.

The Composer Startup screen presents these connection options. See “Connect to a Director” for

details.

e Director on Local Network—Select this option when working while connected to the home
network (inside the firewall). You can modify the project, make connections, add media, and
program the system.

e Remote Director—Select this option when working remotely, but connected to a home network
from the Internet (outside the firewall). You can change your Control4 system as if you were
hooked up to the Local Network (second option). This requires Remote Access. See “Before You
Use Composer HE” for detalils.

2.3.2 Connect to a Director

Control4® controllers have embedded Director software within the controller. Director controls the

communication of devices and allows the automation of your Control4 system. When you connect to a

Director, you can define and customize your project for your system.

Composer HE lets you access, create, and update project configuration. When you want to change

your project to reflect how you want your Control4 system to behave, you connect to a Director using

either a local connection or a remote connection.

This section describes how to:

e Connect to a Local Director

e Connect to a Remote Director

e Grant access to a dealer for remote access

Prerequisites

1. Ensure that you set up your account at http://my.control4.com.

2. Ensure that you have the correct setup, depending on how you want to connect. You can connect
to Director two (2) ways:

e Local Director. Your PC must be on the same IP-based local-area network as your Control4
system.

e Remote Director. Your Control4 system must be configured to use 4Sight Remote Access.

Copyright © 2013 Control4. All Rights Reserved.
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Note: If a Composer HE license is associated with this product, a 'Renew Composer Registration’
message may appear before you can connect to Director. If it does, type your email address,
password, and then click Renew.

Connect to a Local Director
To connect to a Local Director:

Connecting to a Director on the local network lets you configure current settings, download a new
project, or back up an existing project to a file on the PC. Every Director has an associated network
address.

When you start Composer and connect to a Local Director, you are making “live” changes to the hard
drive on the controller; and every time you connect to that Director, you see your project’s
configuration.

1. Start Composer.

Composer

Connect to:

Director on Remote Director
Local Network

B Control(4
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2. Click Director on Local Network. The Directors dialog appears when you connect to a local

Director.

Directors

Steph

wirLiz-test-controller-1 LR
home-controller-10000 w0 E
sharmor_home-conky i R
home-controller-10000 0 i Wi
home-controller-1000 70 3 i {

BRozs Suite_Systers e f i &

(X
M arme Address ~

hame-cantraller-1000000 W ! R Cancel

home-caontraller-1000 00 0 { i Add...

| Int I !
WSPOAPROD2IDIMFSF . 1011 e g

Options available on this page:

= Connect— Lets you connect to the Director that resides on the controller connected to

the local network. This shows the controller's name and IP address.

= Cancel—Cancels and closes the Director dialog box.

= Add—Opens a dialog box that lets you add the Director's Address of the controller to

which you are trying to connect.

= Remove—Removes the controller from the Directors list. Select the controller to remove.

Click Add to add it to the list again.

= Refresh—Lets you update the Director list to display recently-added Directors.

3. From the dialog's list, select the IP address of the primary controller to access, and click Connect.

The main page appears with the Monitoring and List view panes.

2.3.2.2 Connect to a Remote Director the First Time

If you've already connected to Director before, go to "Connecting to a Remote Director” (see below) to

connect remotely.

To connect to a Remote Director for the first time:

When you connect to a Remote Director, you are making “live” changes to a controller remotely.
Changes will be made over an Internet connection rather than over a local network connection.

Note: This type of connection is not available until the initial configuration is complete. It requires
either a temporary connection requested by Control4 Technical Support and granted by you, or a

constant connection to the system made available by activating a 4Sight subscription.
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Temporary Connection: If you are registered on my.control4.com, your controller registration is
completed, and you have remote access. The system is accessible for temporary remote access,
and will be made available to Technical Support personnel when you complete the Check In
process.

Constant Connection: If you've purchased a 4Sight Internet Services subscription and activated
the subscription for your controller through my.control4.com, then the system is always online and
accessible for immediate remote access.

Note: You may revoke access rights to Control4 Technical Support or your Control4 dealer using
my.control4.com at any time; this is not recommended, however, as it will interfere with needed

regular updates.

Start Composer.
Click Remote Director.

After your system is configured for 4Sight Remote Access, you can connect to it using Composer
HE from any Internet connection by entering your 4Sight Account Name, E-mail Address, and
Password.

From the Director dialog that appears, select the Director’s network address for the controller you
are setting up, and click Connect. Choosing the Local Director is essential to Remote Access
setup, as it defines to the system the controller you want to use to log in to the Remote Access
service. This step is done at your home to give you remote access in your system. If necessary,
click Add to add the address manually.

From the Tools menu, click Account Services.

If your system’s current status displays as Registered, you can select the Check In option at the
bottom of the screen to initiate a connection when requested by your Control4 dealer or Control4
Technical Support. The next time your system performs a routine check-in, a connection will be
maintained until the Composer connection exits. If your system’s current status displays as
‘Unregistered,” complete the steps provided on the screen.

2.3.2.3 Grant Access to a Control4 Dealer
To grant access to a Control4 dealer:

1. To grant your Control4 dealer access to your Control4 system, give the dealer access on your
user list at my.control4.com.

Note: Granting a dealer remote access rights to your account does not require that either you or
the dealer reveals any confidential passwords.

2. Onthe Internet, go to http://my.control4.com, enter your email address and password, and then
select Submit.

3. When you access your my.control4.com screen for the first time, follow the on-screen prompts to
enter your 4Sight Subscription Code, and then click Activate. The 4Sight Subscription Code is a
series of digits. Find this code on the card you received when you purchased your Control4 4Sight
Subscription.

4. When successfully activated, you will see an Account Subscription confirmation screen. The
screen shows the information you used to activate your remote account. When you finish
reviewing the confirmation screen, click OK.

5. If you are connected to Anywhere Access, click Cancel or Close.

6. Inthe My Account view with Account Administration selected (left pane), click the Profile link,
and verify the Dealer of Record information.
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7. With Account Administration still selected, click the Users link.

8. At the bottom of the page, check this option: Allow your dealer (your dealer's name) to
remotely access your system.

9. To continue and connect remotely, see the next set of steps.

2.3.2.4 Connect to a Remote Director
To connect to a Remote Director:
1. Start Composer.
2. Click Remote Director.

3. When your system is configured for 4Sight Remote Access, connect to it using Composer HE
from any Internet connection by entering your 4Sight Account Name, E-mail Address, and
Password after you connect to 4Sight.

4. When the ‘Select Remote Account’ dialog appears, select the account you want to access, and
click Connect. If the MyControl4 account name is not in the list:

a. Click Add to add the account name and click OK on the dialog that appears. This is the
Account Name you created during registration at my.control4.com.

b. When the ‘Select Remote Account’ box displays again, highlight your account, and click
Connect.

5. When the Connect <E-mail Address> dialog appears, enter your E-mail Address and Password,
and then click Connect. A screen appears indicating that your account, email address, and
password are being verified, which may take several minutes to complete. When authenticated
and connected through the MyControl4 Remote Access Service, the list of Directors available for
connection displays.

6. Select the Director you want to connect to, and click Connect.

7. When the remote connection is established, Composer HE opens in the Monitoring view.
Composer HE functions normally as if you were connected to a local Director, allowing you to
configure, program, and troubleshoot your system.

2.4 Exiting Composer HE

To exit the Composer HE application click File > Exit. The software asks you if you want to save a
backup of the project file. Click Backup or Backup As to save the project. Control4 recommends that
you back up any changes you make to your project.

3. Exploring the Interface

The Control4® Composer HE interface and wizards are designed to help you
e monitor your Control4 system,

e maintain your media, and

e add or modify custom programs.
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Composer HE main screen:
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To take advantage of the Composer HE features, learn about the following options in Composer:
e Views
e Menu options

The Control4® Composer HE interface is divided into several panes (see above, for example,
Monitoring and List view).

The menu bar (File, Tools and Help) appears at the top of the window.

The upper left portion of the screen displays a project tree and all views available (for example,
Monitoring, Media, Agents, and Programming) in your system with the floors, rooms, and devices you
will define depending on what you want to do. In the project tree, you can click to collapse or expand
the floor, room, or device levels.

The lower left portion of the screen shows the view buttons (Monitoring, Media, Agents, and
Programming). This is where you create automated tasks for your system.

Views

Composer HE has four (4) main views (Monitoring, Media, Agents, and Programming). If you click on
a view button, the appearance and functionality of the Composer interface changes to reflect the
configuration options available for that view.

e Monitoring: Click to view the devices on your system, to access specific device controls, and
to configure the properties of devices.

¢ Media: Click to manage your digital music, movies, and other collections from a disc player,
DVD or CD player, etc. Add and scan stored or broadcast media.
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e Agents: Click to configure an intelligent agent. Use agents in the system and in
programming. Agents include: Lighting Scenes, Wakeup, Scheduler, etc.

e Programming: Click to create and modify custom programming for your system. Program
devices and agents on the system.
Tip: Collapse the views by clicking and pulling down the dotted bar above the view buttons, giving you
more room to view the project tree above.

Note: The project tree was created for you by your Control4 dealer or installer and reflect the floors,
rooms, and devices in your home or business. If the project tree doesn't display, check with your
Control4 dealer.

Monitor and Control Lights, Thermostat, etc. (Monitoring view)

The Monitoring view lets you view all of the devices and their current state for your system, rooms and
devices.

This view
= displays a list all of the devices in a room,
= displays the current state of contact inputs or other devices, and

= |ets you monitor and control the devices contained in the selected location of the project
tree.

When selecting a site, building, floor, room, you can see all devices associated with each other in that
area. If you select a device in the project tree, this view shows all devices that are in the same room.

1. Click the Monitoring view in the Composer HE main window. Two (2) pages in this view show the
‘List View’ screen, which gives you status information for all system devices at a glance: ‘List
View’ and ‘Properties’. If the Control4 system is controlling/monitoring device power, the device is
shown as Red when off, and Green when powered on. The light level, temperature, security
system status, and other details are shown on this screen also.

Copyright © 2013 Control4. All Rights Reserved.

Saved: 6/4/2013 9:59:00 AM 200-00169 Composer HE Page 25 of 48

Getting Started_2.5.0.docx



Composer HE Getting Started

Monitoring view:

Composer 2.2.4
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2. Double-click any device in ‘List View’ to display the controls associated with that device.

3. Click the Properties tab to access the ‘Properties’ pane for all system devices. Select the device
you want to change from the project’s tree view. For example:

= Configure the LED colors on your keypads.

= Configure the LED colors, ramp rates, and preset level for your dimmers.

= Configure/program the ABCD buttons on your System Remote Control for each AV

device.

=  Configure/program the thermostat and its schedule.
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3.1.1.1 Project Tree (Left pane)

The Monitoring view displays the project tree, a hierarchical display of locations and devices. The
project tree is where all of the device drivers for your devices reside in your project. Double-click on a
device to access its device controls.

Monitoring pane:

Composer 2.1.0
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3.1.1.2 Device Control Window

Access a Device Control window for supported devices by selecting and then double-clicking the
device in the project tree (Monitoring view). For example, if you select Left Dimmer in the project tree
under Living Room, the following Device Control screen displays.

Device Con

Dimmer

trol:

Ramp to Level )

\

The Device

Top Current Light Levet Toggle
‘ Eiattomn ‘

Control screen:
lets you test and control a device (after identifying connections) from Composer.

provides you with a simple user interface for device control. For example, the device
control for a dimmer lets you click a button on the screen to turn the dimmer on and off or
change the light level. This is helpful for test purposes.

lets you change the configuration parameters (temporarily) and control a device from
Composer HE. Later, you can set the parameters permanently in the Properties pane or
Programming view. For example, you can adjust the ramp rate of a dimmer to determine
the desired ramp rate to set during programming

3.1.2 Manage Digital Music and DVD Collections (Media view)
The Media view lets you:

= Add and scan your media selections to the system, including stored music and movie
collections or broadcasts channels and stations. In the Media view, the left-side selections
change the right-side views.

= View and select stored or broadcast media from the Navigators (including on-screen
Navigator, System Remote Control, or touch screens that come in a variety of sizes).

= Set up playlists (playlists can be created at the Navigators). When you create or edit a
playlist, you can pick albums or tracks to play.

= Search for cover art (when not loaded automatically) to enhance displays.
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Media view:

Composer 2.1.0

i) Corvmected

This list provides the media types for the Stored and Broadcast Media categories:

Stored Media

CDs. Store CD cover art, albums, artist ratings, and genres (for example, Rock or
Country).

DVD player or disc changer. Store DVD and CD (when DVD supports CD) selections by
viewing cover art, titles, info, results, media, and disc list.

USB Driver or USB drive (CBM Flash Disk). Store a variety of media and access it from
one of these USB-connected devices.

MP3, AAC, or FLAC on Digital Audio Player. Store MP3—HDD music cover art, albums,
artist ratings, and genres (for example, Rock or Country).

Broadcast Media

DIRECTV. View DIRECTV channel options, including station IDs, genres, ratings and
music channels.

Dish Network. View Dish Network channel options, including station IDs, genres, ratings,
and music channels.

Cable TV. View Cable TV channel options, including station IDs, genres, ratings, music
channels.

UHF/VHF. View the UHF channel options, including station IDs, genres, ratings, and
HDTV.

AM/FM/XM and Internet Radio. Scan AM, FM, Internet radio, and XM stations.

1. Click the Media view. The Media Source devices display.
2. Select any source device to modify the media list for that device.

Scan for new music on your network devices: configured USB-attached storage device or
a configured network file store on any network-connected PC.
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Scan for a new DVD in a configured Sony disc changer.

Search for media information using the media lookup service.

Manually customize your MP3, MP4, FLAC, or AAC-formatted albums and songs.
Manually add, edit, or delete DVD information.

Search for the channel lineup on cable, satellite, or off-air programming service. Manually
edit channel lineup.

Create playlists.

Export media lists for backup purposes or import media lists.
Export playlists for backup purposes or import playlists.

Set up Internet radio (your dealer can do this for you).

3. Toadd new MP3 or MP4 files to your collection, copy the files to a configured storage location on
your USB-attached storage device or a configured network storage device.

4. To add a new storage device, have your Control4 dealer add it to the Composer project and
configure it for your use.

The network address of the controller used for your MP3 or MP4 files is
\\<ipaddress>\media\audio where <ipaddress> is your controller's TCP/IP address (for
example, 192.168.0.100). To copy MP3 or MP4 files from your PC to the controller, open
that directory in Windows Explorer and copy the files to a directory in that location.

After you copy the files, use the Media view to select the storage device, and then select
Scan to add them to your Media list.

Customize, if necessary, the metadata for the newly-added media.

3.1.3 Use Intelligent Agents (Agents view)

Agents let you perform more complex programming by using functional modules. For example, the
Scheduler agent lets you program an action using dates and times.

Agents view:

Composer 7.2.4
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Available agents:

4Store

Access

Advanced Lighting Scenes
Announcements
Custom Buttons
Email Notification
Intercom

Light Properties
Lighting Scenes
Media Scenes
Rhapsody
Scheduler

Screen Saver
SNMP Configuration
Timer

Variables

Video Wall

Wakeup

See “Agents Types” in the Composer HE User Guide for a definition of each agent with examples.

This list shows the options available on some agents:

Add—Lets you add agents to your system. Note: Your dealer will need to do this for you.
Remove—Lets you remove agents from your system.

New—Lets you create a new instance to customize the highlighted agent in the Agents
pane (left pane). For each specific instance of an agent, you provide a uniqgue name and
customize it for the specific need.

Copy—(Lighting Scene only.) Lets you copy an existing instance of the highlighted
Lighting Scene agent.

Delete—Lets you remove an existing instance of the highlighted agent.

Agent Navigation pane—Provides each agent a unique interface to set up agent
information in a majority of cases for future programming in the Programming view.

Click the Agents view in Composer HE.

Configurable agents:

4Store—Set up and manage 4Store logins, apps, themes, and storage.
Access—Show or hide icons on your Navigators using a pass code.

Advanced Lighting Scenes—Control lighting throughout your residence or business
from any device—on-screen Navigators, touch screens, and tablets.

Announcements—Create an announcement to display on the touch screens, MyHome
apps, or on-screen Navigators.
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Custom Buttons—Shown on the Navigators. You can create up to four (4) screens with
six (6) buttons each to show on the Navigators in specific rooms or in all rooms in the
system. Use programming to link the Custom Button events to the actions you'd like to
perform.

E-mail Notification—Send email to any Internet mail address. Use Programming
(requires a 4Sight subscription and remote access enabled on the controller) to send out
the notification.

Notes:

1. Remote Access is required to use the E-mail Notification agent. Check with
your dealer for details about using Remote Access.

2. Avoid setting up email notifications for events that occur frequently (e.g., when
a Motion Sensor detects motion). If the email notification trigger event occurs
too often, it will cause the system to become sluggish.

Intercom—Sets up the Intercom system for 5" or 7" In-Wall Touch Screens, the 7” In-
Wall Touch Screen with Camera, 7" Portable Touch Screen with Camera, or the Door
Stations.

Light Properties—Used for Panelized Lighting. Check with your dealer for details.
Lighting Scenes—Customize Lighting Scenes according to your needs.

Media Scenes—Create and configure Media Scenes which are used to link rooms in
your system for audio functionality. Activate and deactivate Media Scenes using the
Agents or Programming views.

Rhapsody—Set up Rhapsody and access the Rhapsody account (requires a Rhapsody
account).

Scheduler—Schedule events to which you can attach programming. Scheduled events
can be based on specific time of day, day of week, and sunrise/sunset times.

Screen Saver—Create a new screen saver to use on your touch screens and on-screen
Navigators.

SNMP Configuration—Manage Control4 home networks remotely. Check with your
dealer for details.

Timer—Create a timer to enable or disable devices at set times.

Variables—Create variables to use in programming. You can create number variables
(numeric), true/false variables (Boolean), and text variables (string).

Video Wall—Control several TVs mounted on a wall.

Wakeup—Incorporate your music selection, light level and ramp rate, and temperature
control to wake you up.

See the Composer HE User Guide for more details.

3.1.4 Program the Control4 System (Programming view)
For the Control4 system to control its devices, you need to configure the behavior of those devices to
occur automatically in the Control4 system. The Programming view lets you write a programming
script using Composer’s drag-and-drop or double-click functions.
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All programming is based on events and actions in a Control4 system. For example, if a door opens, it
is an event. When an event occurs in the system, it can trigger programmed actions to take place. For
example, when the bathroom door opens (event), you can program the bathroom light to turn on

(action).

The Programming view consists of several panes:

Device Events and Project Tree (top left pane)—Displays all devices that have
associated events.

Events (bottom left pane below the Events project tree)—Displays the available Events
for the currently-selected device in the Events project tree. If there are no events for that
device, none are displayed.

Script (center pane)—Displays the Script that is associated with the currently-selected
event from the Events pane. Drag and drop items to rearrange the order and nest items in
the Script pane.

Device Actions (top right pane)—Displays all available device options (in tree form) that
have associated actions you can use to write your script.

Actions (bottom right pane)—Displays the selection of the Command, Conditionals, and
Loops tabs you can select to move to the Script pane. To add an action to the script,
select the action, and then click or drag-and-drop the green arrow or blue question
mark to add the script to the Script pane.

See the Composer HE User Guide for more details about how to create a script.

Click the Programming view in Composer HE. Programming actions occur based on specific events
in the system to make it easy to use and powerful.
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Basics concepts for programming:

= Devices—Each device in the system is seen from two (2) perspectives: (1) functions that
occur on the device (event) and (2) functions that can be done to/using the device
(action). The ‘Device Events’ pane on the left side of the Programming view shows the
events for each selected device. The ‘Device Actions’ pane on the right side shows the
actions for each selected device. Devices include not only the physical devices on the
system, but also the logical devices, for example, rooms and agents.

= Events—When anything occurs on the system, it is an event. Most system events can
have programming attached to them. Notice the specific events that occur on each device
as you select devices. For example, the Control4 wireless dimmer has several events
associated with it: Top Button Pushed, Top Button Released, Bottom Button Pushed,
Bottom Button Released, and so on. The event is the fundamental trigger used in
Control4 system programming.

= Actions—An action is a specific task that the system can perform. Actions are also
device specific. For example, you can set the Control4 wireless dimmer to turn on/off,
toggle, go toa specific dim level and ramping rate, use custom LED colors, or force the
button press/release events to fire.

= Commands—A command is a specific action inserted into the programming script (to the
‘Script’ pane).

= Conditionals—Most devices can be evaluated on a conditional basis. For example, the
conditionals that you can use on the Control4 wireless dimmer are: is the light on, is the
light off, is the light level greater than, equal to, less than, or not equal to a specific level?
The power of conditionals lay with your ability to use conditionals to create programming
which starts with and evaluates current conditions, and then proceeds accordingly.

= Script—The script is the ordered set of conditionals and commands which you associate
with a specific event. Scripts appear in the ‘Script’ pane as you add them. When an event
occurs, the Control4 system executes the script associated with the event.

= Variables—You define variables when you create a Variables agent in the Agents view.
There are three (3) types of variables you can use in programming:

e Numeric—Use Numeric Variables for counting up, counting down, or setting values
based on a number.

e Boolean—Use Boolean Variables to set and track true/false values. For example, when
the Scheduler sunset event fires, you can set a user-defined Boolean variable called
Night_Time to true. When the Scheduler sunrise event fires you can set Night_Time to
false.

e String—A String Variable contains a text string. You can set and evaluate string variables
in programming. For example, you can set a user-defined string variable called
Selected_Playlist equal to "Exercise Music."

e Room Variables—In addition to the user-defined variables you can create, the system also
has system variables attached to each room which you can use when you program your
system. Room Variables are most commonly accessed as commands and conditionals from
the Room device. However, a full set of Room Variables is also available for each room on the

system.
e Programming Control—Use the Programming Control commands to delay or stop script
execution.
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Example: Below is an example that demonstrates some of these concepts. When you start
playing a DVD in the Living room, if it's evening, you want to ramp the lights in the room
gradually to 15%. When the DVD stops or pauses, the lights automatically ramp up to 50%.
When the DVD plays again the dimmer level returns to 15%.

The following steps demonstrate how you'd create the programming for the previous example.
There are three (3) Events: DVD Play, DVD Stop, and DVD Pause.
The only Conditional to check is night time.

Actions are added to the Script pane by either double-clicking or dragging and dropping the
Action’s arrowhead or question mark into the Script pane.

The Commands are dimmer ramp commands.
You can drag and drop a Command arrow on top of a Conditional question mark to “nest” (or

1.
2.
3.

4.
5.

indent) the Command.

The following examples show Stop and Play commands (notice the subtle differences in the dimmer
levels). Detailed information about how to program the system is in the Composer HE User Guide.
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Menu Options
Use the Composer HE menu bar to perform basic file tasks, view the network tools, and view the
online help.

Menu options:

File  Tools  Help
System

The menu bar provides the following menus:
= File—Perform typical file management tasks, load a project, connect to or disconnect
from the Local Director, refresh the Navigators, back up the project, or exit Composer HE.
= Tools—View network status,logs, and account information. Note: Updates are not
supported in Composer HE.

= Help—View the Composer HE Getting Started online help and Composer HE version
information. Links to the Composer HE User Guide are provided in the online help.

File

The File menu lets you perform project file management tasks, load a backed up Composer HE
project, connect to Director, refresh the Navigators (including the touch screens and on-screen
Navigators), create a backup, or exit Composer HE. The file management options relate to the
Composer HE project files you back up on your PC (they have a .c4p extension).

When you set up a Control4 system, you create live project configuration information on the controller
that is backed up to a project file on your PC. This lists specific information about each system,
including devices, connections, configuration, programming information, and media.
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Load Project—Loads a selected project into Composer HE. Composer HE prompts you
for a backup before it clears the project configuration information, and replaces it with the
selected project to load from your local drive.

Connect to Director—Connects you to the selected Director residing on the controller if
there is more than one Director in the network. Composer HE prompts you to back up
your project before connecting another Director. When you connect, project configuration
information from the controller appears on the Composer HE screen.

Disconnect from Director—Disconnects you from Director. Composer HE prompts you
to back up your project before disconnecting you from the currently-connected Director.
This option is available when connected to Director.

Backup—Backs up the current project to your connected PC. The first time you back up,
the software prompts you for a file hame and to back up any media information
(recommended). When you select this option, the current project becomes an option in
the File > Load Project list.

Backup As—Backs up the current project, and prompts you to enter the name of the file.
Composer HE prompts you to back up any media information (recommended). When you
select this option, the current project becomes an option in the File > Load Project list.

Refresh—Refreshes the Composer HE screen with the current project configuration
information from Director.

Refresh Navigators—Refreshes the Navigator screens with the current project
configuration information from Director. Note: MyHome for PC/Mac and tablets must be
updated in the MyHome app. MyHome for iPhone, iPod touch, iPads, and Androids will
update if online.

Exit—Exits Composer HE, and prompts you to back up the project before the software
exits and returns you to the desktop.

Note: The Media menu appears only when you select the Media view.
The following options are available:

Clear Media List—Clears the media list associated with the highlighted device from the
media database.

Export Media List—Exports a media list for the selected device from your controller to
your PC.

Import Media List—Imports a media list from your PC to your controller.
Export Playlists—Exports a playlist from your controller to your PC.

Import Playlists—Imports a playlist from your PC to your controller.

Import DVD List from File—Imports an Excel list of DVDs for disc changers.

New Playlist—Creates a playlist of MP3, MP4, AAC, or FLAC files. The playlist is
available from any touch screen or on-screen Navigator. Add albums, remove songs, re-
order songs, etc. Note: If you remove songs from a playlist, it does not remove them from
the media database.

Delete Playlist—Removes a playlist.
Rename Playlist—Renames a playlist.
Tag media files—Converts media files so all media players can see the same tags.
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3.1.8 Tools

The Tools menu lets you access some tools for checking device connection status:

e System Diagnostics—Assists you to gather system information and help determine if any issues
encountered are configuration problems, performance issues, or potential defects. The System
Diagnostic tool is also valuable for logging information and sending an email message to Control4
Technical Support. See "System Diagnostics" below.

Account Services—Facilitates system registration which is required for software updates and to
use the media services in the system. Account Services is also required in conjunction with a
4Sight account to enable the remote access web service (which allows secure access to your
system via the Internet). See "Account Services" below.

Update Manager—Check with your Control4 dealer or Installer for details about this option.

3.1.8.1 System Diagnostics

Controller Performance tab—View controller performance information including CPU and memory
usage.

System Diagnostics g@@

File  View

Controller Performance | Contraller Networking | System Info | Loaging
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Controller Performance History button—View the history of CPU and memory performance. Click
the History button on the lower right of the screen.
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Controller Networking tab—View controller networking information, including the network type,
connection status, MAC address, IP address, Subnet mask, Gateway, DHCP status, and DNS server

information.

System Diagnostics

File  View

Contraller Performance | Contraller Networking | Spstem Info | Logging|

Active Interface
Interface: Ethernet Status: Cornected
MAL: 00:0F #5 R 4

IP Address
IP address: 10,717, kA Using DHCP: Yes
Subnet mask: 265. 208 44
Gateway: 1011888

DNS Servers
DHNS server1: 10,9100 0 Using DHCP: ‘Yes
DHNS server2: 10.171. 58 54
DNS server3:

Test Internet Connection button—Click to test the current Internet connection.

Conboller Pefoemance | Contralst Netwiding | System Info | Logging
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System Info tab—View System information. Click Save To File to save the displayed text to a file.

System Diagnostics

File  Wiew
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Save ToFile...

Logging tab—Reproduce (if possible) and log system problems.

System Diagnostics

Controller Performance | Controller Networking | System Info | Logaing

Start Logging. Tirne: Device Message

Stop Logging

Open Controller Lag

Auta Seroll Dutput

EN

Clear Dutput

Save Output To File.

Start Logging—Logs the system information.
Stop Logging—Stops logging the system information.

Open Controller Log—Opens the log file if system information was logged.
Auto Scroll Output—Allows the output to scroll through automatically.
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3.1.8.2 Account Services

3.1.9

Set up a my.control4.com account and register a controller. Check the current status and establish a
service connection.

= Controller Registration (Register/Unregister)
= Current Status
=  Service Connection (Check In)

Help

Use the help menu to access the online version of this Composer HE Getting Started document with
Index, Glossary, and search options. Also, you can check the version of your Composer HE software
and Director.

From the Help menu, you have the following options:
= Contents. Displays the Content tab of the Help system.
= Index. Displays the Index tab of the Help system.
= About Composer. Displays the Composer HE and Director versions.

Where to Go from Here

Refer to the Composer HE User Guide on the Control4® website (available as help or PDF). The user
guide provides in-depth information about how to monitor and program your Control4 system. If you
are using online help in Composer HE, links to the Composer HE User Guide are provided from the
help topics.

Control4 strives to support Control4 dealers so they can support you. If you have questions or need
assistance beyond what is provided in this Composer HE Getting Started or the Composer HE User
Guide, please contact your Control4 dealer.
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Glossary

4Sight: An Internet service that provides a connection to the home automation system any time and
from any place worldwide.

4Store: The Control4 app store where you can buy applications for your system. The applications
appear in the touch screens or on-screen Navigators under More > Settings.

AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and
encoding scheme for digital audio. Touts better sound quality.

agent: In Control4 programming, agents provide the ability to perform complex programming by using
functional modules. There are various types of agents; for example, Announcements, E-mail
Notifications, Scheduler, Lighting Scenes, and Wakeup.

Anywhere Access: In OS 2.4 and later, a feature of 4Sight that lets users access and manage their
Control4 systems remotely from the web, smartphone, PC, MAC, or tablet.

action: An activity that occurs when an event prompts it to do so.
AV: Audio Video.

CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4
products.

client: A software or hardware device that communicates to a server for feedback from the server via
an application for the user.

Command: A ‘do’ statement; actions the Director communicates to a device.
Composer: The Control4 software used to design and define a Control4 home automation system.

Composer Pro: Composer Pro is used to set up and configure Control4 devices to communicate with
each other in a home automation system. The dealer uses this software to create and configure the
project for the customer.

conditional: An ‘if’ statement that asks true/false questions, which are acted upon in Composer
programming.

connection: Devices that are bound or linked together in Composer so they can communicate with
each other.

contact: Contacts are generally used to monitor the status of something (door, window, water sensor,
etc.) and can be connected through a security panel or directly using a Control4 controller or
Contact/Relay Extender. Contacts connected to a Control4 controller or Contact/Relay Extender can
be configured either as NC (normally closed) or NO (normally open).

Control4 system: A home automation system designed and developed by Control4.

controller: The main device that makes home automation possible. There may be multiple controllers
within a Control4 system. The controller that runs Director is referred to as the primary controller. The
other controllers in the system are secondary controllers.

device: A component that requires a device driver; code that is used to allow the Control4 system to
work with that device. Device drivers are added to the project tree in Composer by the dealer.

device driver: Every device in the Control4 system needs a corresponding device driver to control
that device.

DHCP: DHCP (Dynamic Host Configuration Protocol). A protocol used between a network client and
a DHCP server (usually a router or access point) that dynamically assigns IP addresses from a pre-
defined list to clients on a network.

Director: Each Control4 controller (such as an HC-800 Controller) ships with pre-installed Director
software (Linux based) embedded in the device. The Director communicates with Control4 products
and third-party products to enable home automation and interaction of devices. Director runs the
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Control4 devices. Composer Pro is the software used to connect to and program a system Director
that resides on a controller.

DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-
AV devices.

DVD: (Digital Versatile Disc) — A media format for video and data storage.

end point: The end point is the final point (device) on the defined path over which audio and/or video
content is routed to a room. An example of this would be a TV or receiver.

Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star
network topology that allows multiple points to communicate to a single point. The Speaker Point®
uses Ethernet to communicate to the Control4 controller.

event: An action; used to trigger Composer programming when programming Control4 devices.
file format: A format used by applications to store/read files.

FLAC: Supported by Control4 since software release 1.8; this is a free, open source, lossless audio
codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in
quality.

gateway: (router)- Provides a means of communicating between two separate networks.

home network: A network installed in the customer’s home that provides an Ethernet or wireless
connection so that Control4 devices can communicate with each other.

home automation system: The Control4 system: a line of home automation products that
communicate with each other over Ethernet, WiFi, or ZigBee for a total home automation experience.

identify: Your Control4 dealer or installer will identify a device to the Control4 system after they add
the device driver to the project tree. This ensures that the device can communicate with the Control4
controller and Director.

intercom: A two-way audio and/or video communication among supported Control4 devices.

IR: Infrared light—Some network devices can be controlled by a wireless remote control that uses
pulses of infrared light to send commands to the device.

LCD: (Liquid Crystal Display) - A display used with some Control4 interfaces.
LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen.

LED: (Light Emitting Diode). Primarily used in dimmers, switches, and keypads, but LEDs are also
used on other Control4 devices for status purposes.

Linux: An operating system used by several Control4 devices.
List Navigator: Menu options that are visible on a System Remote Control.
live connection: A term used in Composer Pro to indicate an actual connection to the network.

loop: A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers are
on..."

media database: Media information is stored in the media database, which will permit users to view
the media from the Navigators.

MP3: A music format that makes streaming audio available.
MP4: An audio and video format. Can also store images and subtitles.

MyHome: An app that lets users manager their Control4 systems from an iPhone, iPad, iPod touch,
PC, Mac, or tablet device.

Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc.
Navigator is software that the customer interacts with using a Control4 System Remote Control, on-
screen Navigator (TV screen), or touch screen.
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on-screen: Allows you to select the controller (e.g., HC-800 Controller) in the room that controls the
source for the on-screen display.

playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or
any combination of the above.

Power Over Ethernet (POE): Network cabling that provides Ethernet connectivity and device power
over a single cable. Commonly used for Control4 devices.

primary controller: The main device that makes home automation possible. There may be multiple
controllers within a Control4 system. The controller that runs Director is referred to as the primary
controller.

programming: A machine-readable artificial language used to express computations that can be
performed by a device.

project tree: A tree view in Composer where the project is layered by the larger branches (Home,
Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

ramp rate: The rate that a dimmer ramps up its voltage.
relay: An electrical switch that opens and closes. A relay is controlled by another electrical circuit.
remote access: The ability to access a device from a remote location.

Remote Director: Connects you to the home network while working in Composer from a remote
location.

retrofit: The ability to set up a home automation system in an existing structure or home. Compare
this with new building construction.

RJ-45 jack: An eight-pin jack used to connect CAT5e network cables to Ethernet devices.

router: See gateway. Functions similar to an AP but with additional functionality for controlling the
network; for example, coordinating traffic between different networks.

secondary controller: Other controllers in the system that do not run Director or are used as the
primary controller.

serial-controlled device: Serial-controlled devices with an RS-232 interface and control protocol
often have a higher level of controllability than IR-controlled devices. Examples of serial-controlled
devices are projectors, multi-disc DVD changers, etc.

switch: An extension of a router that adds more Ethernet ports to support additional devices or clients
on the local network.

system event: An action that causes another action; for example, if a projector turns on, it enables
the other devices in the system that work with the projector.

System Remote Control: A Control4 System Remote Control is a universal solution that replaces
remote controls from other manufacturers, and includes programmable buttons. This System Remote
Control can access on-screen Navigators.

touch screen: A touch screen is a home automation system Navigator that controls the home’s
lighting, music, videos, and other devices on the home automation system.

Ul (user interface): The preferred term is Navigator. The Control4 interface used with Control4
devices to control home automation, for example, touch screens, or on-screen Navigators, and
devices that use MyHome.

universal remote: Universal remote control. A third-party remote control that can be programmed to
replace other remotes in the home so that only one remote is needed, replacing all others. A Control4
System Remote Control is a type of universal remote control.

USB: (Universal Serial Bus) - A connector format used with USB drives that connect to a USB port on
Control4 devices.

Virtual Connection: A term used in Composer Pro to indicate a connection outside the network.
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Virtual Director: A connection to a virtual controller only (a PC is the Director host rather than the
controller). Projects created or edited here are benign until the saved project is loaded onto a
controller.

WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices
“connect” to each other by transmitting and receiving signals on a specific frequency of the radio band
using a wireless access point. This technology uses the star network topology. WiFi uses high-
bandwidth 802.11.

wired network: Uses Ethernet Category 5 or 6 (CAT5 or CAT6) wiring to send and receive data
between devices connected to a network.

wireless access point: A router extension with an antenna that communicates with WiFi devices and
clients in the home. A wireless hub that connects to a wired network and distributes a wireless signal
throughout the structure.

wireless dimmer: A Control4 dimmer that uses the ZigBee. UL listed.
wireless switch: A Control4 switch that uses ZigBee. UL listed. Has an air gap to cut power.
WLAN: Wireless Local Area Network.

ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer
messages from one device to another. Unlike a star network topology where devices can only send
messages to each other by sending them first to a single central device (which then delivers the
message to the recipient device), a mesh network topology allows the devices to forward messages
from one device to another, thereby extending the effective range of the network. Uses low bandwidth
802.15.4. Up to 250 devices are allowed per controller, but Control4 recommends a maximum of 125.

ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: allowing

more interoperability with other Control4 devices, support for home automation profiles, and improves
the scalability of multiple ZigBee access points.
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